
6 Reports and support tickets

A major feature of L&TT is the ability to generate reports and support tickets. In the event of a hardware
problem, a report or support ticket can provide vital information to help diagnose and resolve the
problem. Reports and support tickets can be generated on all operating systems supported by L&TT.

Much of the information stored within a device related to operational characteristics is used by various
L&TT tests to analyze the health of the device. However, not all information can be used in this automated
fashion. Some information requires review by qualied HP personnel to fully diagnose the situation. For
this reason, a report or support ticket should be generated and e-mailed for further analysis when
requested.

When a report or support ticket is generated, L&TT collects conguration information and executes
a Device Analysis test on the selected device. This information can then be viewed, saved, printed,
compared to another report or support ticket, or e-mailed. By default, a support ticket is saved as a single
compressed tar le with a .lzt extension to the logs directory.

While support tickets contain highly technical data that is intended primarily for HP support personnel
and developers, L&TT reports present the technical information in a more user-friendly way. You can think
of a report as an enhanced, user-friendly support ticket. Currently, reports are only available for LTO
drives, but support tickets for other devices are continually being upgraded to the new report format and
will eventually replace support tickets. However, the classic� support ticket will always be available when
the report is viewed with the detail level set to Everything or Factory only.

As of L&TT version 4.1, reports are only available for LTO drives. Support for other hardware will be
added with later releases of L&TT.

The report viewer is built into the L&TT application and is used to view both support tickets and reports.
View detaileddevice information and general information about the system it is connected to with the
viewer. The user (or support technician) can change the detail level of the support ticket or report, browse
through the information, and expand or collapse specic sections of the support ticket or report.

Keep the following information in mind when generating and viewing support tickets and reports:

� In the event of a device failure (or suspected failure), generate a report or support ticket for that
device as soon as possible to increase the chance that relevant failure data is captured.

� If L&TT is used to generate a support ticket on a library that is managed by HP StorageWorks
Command View for Tape Libraries Software (Command View TL), it will not include the IM and
IFC logs. To ensure that all log data is captured, support tickets should be generated using the
Command View TL GUI or CLI, as documented in the HP StorageWorks Interface Manager and
Command View for Tape Libraries Software user guide. If the library is partitioned, be careful
when interpreting support tickets because the values in the logs are based on the actual physical
library, not the partitioned library, so drive and slot numbers do not directly match those numbers
reported by the backup application.

� Regardless of the selected detail level, the log le always contains all of the information collected
from the product. The report viewer lters and parses this information, depending on the detail
level.

L&TT reports and support tickets are saved in a proprietary format and require the report viewer.
However, with the Windows version of L&TT, a report or support ticket can be converted to HTML
format and printed or viewed by other users without the report viewer. As of L&TT version 4.2, you
can also save a support ticket as an XML le.

Make sure that the detail level is set to the desired level before generating the HTML report because
the detail level within the HTML le cannot be changed.
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� When generating a report or support ticket for standalonedevices, HP recommends that you keep
the media in the drive in which it was present when the failure occurred. This allows error rate
and other information relevant to that cartridge to be examined. When media is removed, many
devices automatically clear this information. For tape automation products, it is generally better to
have the drives empty of media to force the library drive/media log to be updated.

� The Windows version of L&TT is the preferred platform for working with reports and support
tickets. Comparing or printing reports and support tickets is only supported with the Windows
platform. E-mailing reports and support tickets is supported on all L&TT-supported operating
systems with the exception of NetWare. You should view reports and support tickets with the
Windows version of L&TT to provide unrestricted analysis.

� In the Windows version of L&TT, right-clicking any of the text in the report viewer displays a
context menu with more options. To quickly see the entire support ticket or report, set the detail
level to Everything or Factory only, right-click the top entry, and select Expand All.
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Using a report or support ticket (Windows)
The use of reports and support tickets is essentially the same. The main difference is that reports

have an enhanced format that presents more useful information to the average user. Support tickets contain
log data and other information that is primarily intended for HP support personnel and developers. The
procedure for accessing reports and support tickets is the same (with the exception of the Health button,
which is explained below). However, reports are not yet available for all supported devices. If a report is
available for the selected device, it will be generated. Otherwise, a support ticket will be generated.

Reports and support tickets can be generated in two ways:

� Generate reports and support tickets from the support screen. The support screen gives you the
option of viewing, saving, or e-mailing the report or support ticket.

To access the support screen:

1. Select a device in the device list (By Product or By Connection tab).

2. Click Support on the main toolbar.

� Generate reports with the Health button. This is the preferred method for quickly generating and
displaying a report.
1. Select a device in the device list (By Product or By Connection tab).

2. Click Health on the main toolbar. The report is generated and automatically displayed in the
report viewer using the Normal detail level.

If the report format is not yet available for the device selected in step 1, the Health button
will be grayed out. In this case, use the support screen to generate a support ticket.
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Using the support screen
Reports and support tickets are generated from the support screen. If the report format is available for the
selected device, a report will be generated. Otherwise, a support ticket will be generated.

Figure 25 Support screen

To generate a report or support ticket, you must rst extract the device data. Click Extract Device Data to
generate the report or support ticket. After extracting the device data for the rst time, the Extract Device
Data button text changes to Refresh Device Data. You should refresh the device data whenever a change
is made to the device that can affect the support ticket, such as running a test or loading/unloading a
cartridge.

After extracting (or refreshing) the device data, the following three options become available:

� View Support Ticket�Click this button to view the report or support ticket in the report
viewer. The report or support ticket can later be saved or sent via e-mail. For more information,
see "Viewing a report or support ticket" on page 119.

� Save Support Ticket�Click this button to save the report or support ticket. For more
information, see "Saving a report or support ticket" on page 121.

� Send Support Ticketby E-mail�Click this button to send the report or support ticket via
e-mail to an HP support center (or other destination). Clicking this button opens a form that allows
you to provide all the necessary information. Complete the form and click the Send button to
send the e-mail. Using this option doesnot save a copy of the support ticket locally, so you are
advised to click Save Support Ticket to save a copy for future reference. For more information, see
"Sending a report or support ticket by e-mail" on page 123.

In addition to the above options, the bottom section of the support screen provides resources for nding
support on the Web. Click any of the buttons in the Support Resources on the Web section of the screen
to open a browser window and view the corresponding website.
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Report and support ticket compression
When you save or e-mail a support ticket, L&TT generates a single, compressed support ticket le. The
support ticket includes the master support ticket le, sticket_header<time>.ltt, and one or
more VidPid_UID.ltd data les.

Viewing a report or support ticket
After a report or support ticket is generated, it is displayed in the report viewer. Click the �+� and ���
signs to expand and collapse sections of the support ticket. Use the standard navigation keys (Home,
End, Page Up, Page Down, and the arrow keys), the Windows scroll bars, and the mouse to navigate
through the document.

To print the report or support ticket, select File > Print from the menu bar within the report viewer.

Setting the detail level
Reports and support tickets can display information in several different levels of detail, depending on the
setting displayed in Current Detail Level. The following detail level settings are available:

� Highlights only (not used with reports)
� Normal
� More details
� Everything (the highest level a customer can view)
� Factory only (Requires a factory password. Contact HP support to obtain a factory password.)
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Figure 26 Example report

Other functionality
Right-click any line in the support ticket viewer to display a context menu that exposes additional
functionality. Depending on the line that was clicked, the following items may or not be available
(unavailable items are greyed out):

� Expand All�Expands all subitems.
� Event Explanation�Opens the Event window that displays additional information about the event.

You can view the data in either ASCII or hexadecimal format. This feature is available for items
preceded with the blue information icon ( ). See Viewing embedded data for more information.

� Event Data�Opens the Event Data window that displays L&TT-specic information about the event.
� Copy�Copies the current line to the Windows clipboard.
� Reference Data�Opens the Reference Data window that displays reference information pertinent

to the current line such as valid ranges and applicable values.
� Find Sub-Tree�Search for a particular sub-tree.
� Copy Sub-Tree�Copies the current sub-tree to the Windows clipboard.

Viewing embedded data
When viewing a support ticket for an interfacecontroller in an Enterprise Tape Library having an Interface
Manager card with rmware revision I160 or higher, the support ticket only displays a Data node that
contains an HTML report page compressed into a zip le. This HTML report page contains all the data
previously displayed through the report viewer for the Interface Controller support ticket and more. The

Data node is preceded with the blue information icon ( ), as shown in Figure 27.
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Figure 27 Support ticket with embedded data

To view the embedded data:

1. Double-click Data to openthe Event viewer.

Figure 28 Event viewer

2. Select Hex to view and save the le as a binary le.

3. Click Save As and save the le with a .zip extension.

4. Extract report.htm from the .zip le and openit in a browser window.

If you are using Internet Explorer, depending on security settings, you may see a message
stating that Internet Explorer has blocked ActiveX content. In this case, click the security alert
at the top of the browser window and select Allow Blocked Content from the context menu.

Saving a report or support ticket
When you save a support ticket, L&TT generates a single, tarred, zipped support ticket with the
.lzt le type in the logs directory. The support ticket is named st_<date>_<time>_<serial
number>.lzt by default. The support ticket is a compressed, tarred le containing the master ticket le,
sticket_header<time>.ltt, and one or more VidPid_UID.ltd data les for each device.

For legacy 3.x large libraries, including SureStore 2/20, SureStore 4/40, SureStore 6/60, SureStore
6/140, SureStore 10/100, SureStore 1/9, and the MSL5000 and MSL6000 series libraries, the tarred
support ticket contains a single compressed .dat le.
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To view the saved support ticket, openthe .lzt le using Windows Explorer, or use the Load command
on the L&TT File menu.

To view or e-mail the individual les, rename the .lzt le so it has a .tar le extension and use
WinZip to extract the les to a single directory. The master ticket le will have a .ltt.lzo extension,
and the data les will have .ltd.lzo extensions. You can open the master ticket le with Windows
Explorer or with the Load command on the L&TT File menu.
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Sending a report or support ticket by e-mail
From the Support screen, click Send Support Ticket by E-mail to generate the support ticket and
immediately send it via e-mail to an HP support center (or other destination). The E-mail Support Ticket
dialog box opens.

Figure 29 E-mail support ticket dialog box

Before L&TT can e-mail a report or support ticket, you must either have a MAPI-compliant e-mail program
(such as Microsoft Outlook or Outlook Express), or you must set up an e-mail account through the
Windows Control Panel or Internet Explorer. For more information about setting up an e-mail account, see
"How do I congure e-mail to send support tickets?" on page 171

The E-mail Support Ticket dialog box is divided into three steps:

1. In Step 1, indicate whether this is a new support request or an existing case.
� If this is a new support request, select Send to support provider to request support by e-mail.

Enter the product number and product serial number in the appropriate elds.
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� If this is an ongoing support case, select Send to support provider in reference to an open
case and enter the case reference number in the appropriate eld.

2. In Step 2, enter the destination e-mail address. Use the dropdown box to select from a list of
HP support providers, or enter the e-mail address manually. Two valid e-mail addresses are
offered, both for the North American region:
� LTT North America Support Call Center lttna@hp.com (for all North America except 3rd

party outsourcer use)
� LTT North America Support Call Center lttna20@hp.com (for 3rd party outsourcer use)

Customer support personnel typically provide an e-mail address to users who are e-mailinga
support ticket as a resultof a support call request. In this case, the user should enter the e-mail
address exactly as provided by the support person. In the European region, this will usually be
provided in the form: "<xxx>@cases.brussels.hp.com" where is the actual assigned case
number. This associates the support case number with the support ticket, making resolution and
tracking more manageable.

3. In Step 3, specify the following additional information:
� Contact information�Enter your company name, contact name, contact phone, and contact

e-mail address.
� Attach Result Log�Attach the support ticket to the e-mail for analysis by HP service personnel.
� Attach additional Event Log (only if requested)�Sendthe event log if requested by HP

service personnel.
� Problem description�Enter a detailed description of the problem you are having.

When you have completed the form, click Send.

L&TT defaults to 10 MB for maximum size for any e-mail. If your e-mail setup will not permit e-mail les
as large as 10 MB, click L&TT Options > Preferences, click the check box for maximum e-mail size, and
then enter a smaller number. If you attempt to e-mail a support ticket using L&TT that is larger than the
maximum e-mail size, L&TT will not send the e-mail. In this case, you can save the .lzt support to your
disk. Rename the le to have a .tar le extension, and then use WinZip to expand the support ticket
into a single .ltt.lzo le and one or more .ltd.lzo les. You can e-mail these les individually.
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Comparing reports or support tickets
To compare two reports or two support tickets and generate a report of the differences:

1. Generate or openthe rst report or support ticket to be compared.
2. In the report viewer, select File > Compare. The Open dialog box opens.
3. Select the report or support ticket to which you want to compare and click Open. The comparison

results are displayed in a separate window.

Figure 30 Support ticket comparison results

Interpreting a report
The information displayed in the report will vary greatly depending on the device being analyzed and
the detail selected. The following report sections may or may not be displayed for any particular device:

�
� Health�This section contains a summary of whether the drive is Fit For Purpose (FFP). If there are

any issues identied, then they are explained and corrective action suggested. The Health section
also highlights remaining margin relating to the remaining life of the drive/media.

� Conguration�This section allows you to check the conguration settings of the drive or interface.
The items in this section are usually set by the backup application or HBA.

� Environment�This section displays any known information about the environment in which the
device is operating (such as temperature).

� Performance�This section displays information regarding the recent performance of the device,
such as recent native transfer rates, compression ratios, and so forth.

� Usage�This section shows usage information for the device since it was new.
� History�This section displays any signicant events that have happened (and have been

recorded by the device).

For a more detailed explanation of device-specic information displayed in each section, see
"Device-specic report analysis" on page 127.
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Understanding the margin ratings
When a report is generated, several tests are performed to measure drive performance for every aspect of
operation. Each function that is tested is assigned a margin rating. Margin is expressed as a percentage
where 0% is no margin, but the device should still work. 100% is full margin, or production quality. A
working drive will have positive margin, whereas negative margin indicates an issue. The percentages
are also mapped to simple wording as follows:

< 0% Warning

>= 0% and < 25%
Fair

>= 25% and < 50% Good

>= 50% Great

Corrective action should be considered if the margin doesnot meet the levels of condence that the data
requires. For example, a nightly backup probably doesn�t need the same level that a ten year archive
does. In general, corrective action is only required if Warning is shown, but Fair suggests possible future
issues, and corrective action could prevent such issues from occurring.

Corrective action could take the form of:

� Cleaning the drive
� Trying another tape (look at the tape history to see if other drives have had similar issues)
� Checking the environment. Temperature extremes can have an effect. Contamination can be a

signicant issue.

If in doubt, run the L&TT Drive Assessment testwith a trusted (or new) tape. This is the test approved by
HP support to give the most accurate assessment of drive health. If a drive passes this test, it is considered
to be good. If it fails (and the tape is good), then HP support will exchange the drive.

Things to look for
After generating the report, look for the following trouble indicators:

� Device Analysis Rules�These are device-specic items that L&TT tests. These rules are displayed
in the Drive Health section under Device Analysis. This is the rst place to look for health
information and advice on corrective action.

� Drive health varying with different tapes�In this case, the tapes are most likely causing the
variation.

� Tape health varying with different drives�In this case, the drives are most likely causing the
variation.

� A drop of margin over time�Rapid drops can indicate contamination.
� Tapes nearing the end of their working life�Older tapes are less reliable and may need to be

replaced.
� Drives nearing the end of their normal working life�This is unlikely because the estimated

lifespan of HP drives is very high.
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Device-specic report analysis
This section explains device-specic report data. Currently, the report format is only available for LTO
drives and media. As support for the report format is added to other devices, the information will be
added to this section.

Click the relevant link to jump to that section:

� LTO drives
� LTO media

LTO drives
The report groups information into the following standardized sections, and wherever possible, identies
the drive and media as separate devices.

� Identity
� Health
� Conguration
� Environment
� Performance
� Usage
� History

Identity

This section shows the identication of both the drive and the interfaces. The Format entry also indicates
compatibility.

Health

This section is split into two main sections: Device Analysis and Write/Read margin data.

� The Device Analysis section shows the output of the device rules. This is the rst place to look for
health information and advice on corrective action.

� The Write/Read margin data section shows the write and read marg inof the last ve tapes
(current and previous four tapes).
� The summary line (top line of this section) shows the average and worst margin values found in

the available history. The Current tape and four Previous tape lines show margin information
for the last ve tapes used. If there is a margin warning for one tape, then that suggests a
suspect tape. Cross check with the cartridge history below or try the tape in another drive. If
there is a margin warning for all tapes then the drive itself is suspect. Try cleaning the drive
and run the Drive Assessment testto check the drive.

� The Head life, Reposition life, and Load/unload life lines show life gures for the drive.

Conguration

This section shows conguration information for the drive and its associated interface controller.

� In the Drive section, useful conguration information is listed which can assist with troubleshooting
potential drive problems. For example, the report records the current data compression setting of
the drive, and whether the backup application has prevented media removal.

� In the Interface section, verify that the negotiatedburst rate is as expected. This value should
match the data shown for the interfacecontroller in the Drive Identity section (the name of the
controller generally indicates the maximum speed that the interfacecan handle).
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Environment

This section shows temperature data for the drive. Verify that all temperatures shown are within normal
limits.

Performance

This section shows burst performance gures for the drive, and estimated native performance gures
for the last four tapes.

� Maximum data rates show the highest rate that the data compression engine has seen. Figures
are high because of buffering. These values show the maximum possible rates with very high
compression ratios.

� Average data rates before compression are what the host has seen. Average rates after
compression are the native rates for the tape.

� Write and read compression ratios are calculated over the same data. These gures are reset on
tape load, in which case Unknown is shown.

� Performance gures are estimated from various drive logs.

Usage

This section shows usage data for the drive since it was new, as well as the amount of data transferred
over the current and previous four tapes.

The Tape pulled item is expressed in full volume equivalents as that is closest to a customer model. HP
media documentation also uses this unit.

History

This section displays drive logs that show what the drive has been doing. The event log shows high-level
information on commands received, internal processing, and any errors returned to the host (including
tape alert information).The event log also includes history from Device Analysis and Drive Assessment
tests. The times shown are relative to the last power on.

LTO media
This section displays information on the currently loaded tape (header displays loaded tape), or the tape
that was loaded last (header displays ejected tape). If you are using genuine HP media, more information
is displayed in this section than would be with non-HP media.

This section has several sections and sub-sections:

� The Identity section shows the identity of the media. Note that the Barcode item is not used
by all products.

� The Health section is split into three sections:
� The Data on tape section shows margin measurements for the data on the tape. Data on tape

is written in wraps where each wrap is a pass up or down the tape. Each generation of LTO
has a different number of wraps. Each wrap has a measure of margin revealing any bad
spots on the tape. The summary line (top line of the section) highlights the worst margin found
and should be used for a measure of minimum quality of the whole tape. The last used wrap
usually displays partially written. Only fully written wraps can be measured for margin.

To the right of the margin indicator for each wrap is a text-based bar chart that graphically shows
the margin rating. The zero in the middle represents 0% margin, and the carat (^) represents the
actual margin of the wrap. This is helpful to visualize margin across the tape if a bad area
covers more than one wrap.

� The Drive measurements section shows data from the error rate counters of the drives the
cartridge was used in. The summary line shows the worst margin found in the available
history. If there is a margin warning for one drive but good margin for the other drives, then
that suggests a suspect drive. Try cleaning the drive and run the Drive Assessment testto check
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it. If there is a margin warning for all drives, then the cartridge itself is suspect. Cross check
this information with the Drive History section of the report.

� The Write/read life and Load/unload life items show cartridge life estimates based on usage
and published expected life gures with HP drives. Because HP drives are tuned to work with
genuine HP media, HP media can be expected to have a longer usage life.

� The Conguration section shows whether the cartridge is write protected and WORM enabled.
Note that WORM is only supported with LTO3 and later drives.

� The Environment section shows data for the current and previous drive environment. Watch
for warnings even in previous drives. This information can be useful to track down system hot
spots or cooling issues.

� The Performance section shows performance data for the cartridge in the current drive, as well
as the previous two drives. Performance gures from previous drives are estimated from the
amount of data transferred and the time spent pulling tape. If less than 60 seconds of tape
pulling have occurred, then the message Not enough data is displayed because the estimate
is likely to be inaccurate.

� The Usage section includes how much of the cartridge capacity has been used (all gures native)
and usage over the available history of previous drives. The total write/read data volume and
load count since new are also shown.
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Generating and viewing a support ticket (CSI)
To generate and view a report or support ticket in the CSI environment:

1. From the Main screen, select the device for which to create a report or support ticket. The
device information screen opens.

2. Enter the support command to access the Support screen. Alternatively, if the report format
is available for the selected device, then you can use the health command to access the
Support screen.

The functionality of the Support screen is the same, regardless of which command you used to
access it.

3. From the Support screen, enter the extract command (or the refresh command).

After extracting a report or support ticket for a device for the rst time, the extract command is
replaced with the refresh command. Refresh the device data whenever a change is made to the
device that can affect the support ticket, such as running a test or loading/unloading a cartridge.

4. After extracting (or refreshing) a report or support ticket, do one of the following:
� Enter the view command to view the support ticket.
� Enter the save [<arg>] command to save the report or support ticket.

L&TT generates a support ticket in the logs directory. The report or support ticket can later be
viewed (using the load command from the Main screen) or sent via e-mail.

� If no argument is specied, L&TT generates a single, compressed le in the logs directory.
By default, the name of this le is st_<date>_<time>_<serialnumber>.lzt,
although you can specify another name on a subsequent screen if desired. The support
ticket is a compressed, tarred version of the following les:
� sticket_header<time>.ltt
� One or more VidPid_UID.ltd

� If you specify an argument with a path and lename, as in this example:

/opt/temp/abc.lzt
L&TT creates the support ticket abc.lzt in the /opt/temp directory.

� If you specify an argument with only a lename, as in this example:

abc.lzt
L&TT creates the tarred support ticket abc.lzt inside the /opt/ltt/logs directory. L&TT
will add the .lzt extension if it is not included in the lename.

� Enter the send command to send the report or support ticket by e-mail. See "Sending a
support ticket by e-mail (CSI)" on page 131 for more information.

When viewing the support ticket, use Ctrl+U and Ctrl+D to scroll up and down through the results. You
can also use the find and page commands to quickly locate information.

Support ticket compression
When you save or e-mail a support ticket, L&TT generates a single, compressed support ticket le. The
support ticket includes the master support ticket le, sticket_header<time>.ltt, and one or
more VidPid_UID.ltd data les.
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L&TT defaults to 10 MB for maximum size for any e-mail. If your e-mail setup will not permit e-mail les
as large as 10 MB, click L&TT Options > Preferences, click the check box for maximum e-mail size, and
then enter a smaller number. If you attempt to e-mail a support ticket using L&TT that is larger than the
maximum e-mail size, L&TT will not send the e-mail. In this case, you can save the .lzt support to your
disk. Rename the le to have a .tar le extension, and then use WinZip to expand the support ticket
into a single .ltt.lzo le and one or more .ltd.lzo les. You can e-mail these les individually.

Sending a support ticket by e-mail (CSI)
To generate a support ticket and send it via e-mail:

1. From the Main screen, select the device for which to create a support ticket. The device
information screen opens.

2. Enter the support command to access the Support screen.
3. From the Support screen, enter the send command to display the Send Support Ticket screen.

The Send Support Ticket screen displays a list of several parameters that must be entered before the
support ticket can be sent. The screen displays the current values for each parameter.

4. Enter the number of the rst parameter, and then enter the parameter data at the prompt.
5. Repeat step4 for each remaining parameter and option. When entering the e-mail address, two

valid e-mail addresses are offered, both for the North American region:
� LTT North America Support Call Center lttna@hp.com (for all North America except 3rd

party outsourcer use)
� LTT North America Support Call Center lttna20@hp.com (for 3rd party outsourcer use)

Customer support personnel typically provide an e-mail address to users who are e-mailing a
support ticket as a resultof a support call request. In this case, the user should enter the e-mail
address exactly as provided by the support person. In the European region this will usually be
provided in the form: "<xxx>@cases.brussels.hp.com" where is the actual assigned case
number. This associates the support case number with the support ticket, making resolution and
tracking more manageable.

6. When all the required parameters and options have been specied, enter the send command to
generate and send the support ticket.
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Loading or opening support tickets
L&TT version 4.2 supports opening the following support ticket le types:
� .lzt � tarred support ticket
� .ltt � master ticket le (Windows only)
� .ltd � data les
� .lzo � compressed les, including .lzt.lzo, .ltt.lzo, .ltd.lzo
� .dat � L&TT 4.0/4.1 and L&TT 3.x data les (Windows only)

To load or opena support ticket on Windows (GUI), do one of the following:

� In the L&TT main screen File menu, select Load Support Ticket.
� In the L&TT Report Viewer File menu, select Load as.
� Open the le in Windows Explorer, except .dat les.

To load a support ticket from the CSI:

� In the main screen, enter load <path and filename>.
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Using XML support tickets
Starting with L&TT version 4.2, L&TT can generate a support ticket in XML format. The XML-format support
ticket includes additional properties that do not appear in the report viewer view, but are helpful when
comparing multiple support tickets for a device.

Generating an XML support ticket (GUI)

To generate an XML support ticket on Windows:

1. In the Support Ticket pane, click the View support ticket tab to openthe Report Viewer.

2. Select the Current Detail Level.

3. In the File menu, click Save as XML le.

Figure 31 Save as XML le menu item

4. Enter the le name. By default, L&TT saves the support ticket in the logs folder with the name
SupportTicket.xml.

To generate an XML support ticket from a saved support, open the saved ticket in the Report Viewer and
follow the directions above to generate the XML support ticket.

Generating an XML support ticket (CSI)
To generate an XML support ticket, extract the report or support ticket and then do the following:

1. Enter the View command to view the support ticket.

2. If you want to change the Current detail level, enter detail<level>.
3. Enter savexml [<arg>] to save the support ticket in XML format.

� If no argument is specied, L&TT saves the XML ticket with the default lename
SupportTicket.xml in the /opt/ltt/logs directory.
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� If you specify an argument with a path and lename, as in this example,
/opt/temp/abc.xml
L&TT saves the XML ticket with the name abc.xml in the /opt/temp directory.

� If you specify an argument with the lename only, as in this example,
abc.xml
L&TT saves abc.xml in the /opt/ltt/logs directory.

Figure 32 Saving an XML support ticket
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Common information reported for all products

For standalone devices (such as DDS drives), HP recommends that you generate a report or support ticket
when the drive still contains the media with which the drive may have failed. This allows error rate and
other information relevant to that cartridge to be examined. When media is removed, many products
automatically clear this information. However, for most SureStore tape libraries it is better to have the
drives empty; this forces the library drive/media log to be updated.

The following information is included in the support ticket regardless of what products are being analyzed:

� System information provides basic host system information such as operating system, processor
type, system name, physical memory size, and the current version of L&TT being used. This
information also includes a snapshot of the SCSI bus conguration determined by the I/O scan,
showing connected devices listed physically and logically.

� L&TT history provides a brief history of the L&TT functions the user has accessed such as whether
ASPI was installed, how many times L&TT has been run, and which functions have been used.
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Using the event log
L&TT can generate a detailed event log that captures all L&TT diagnostic interaction, all SCSI commands
sent and received by the program, and any software interactions or issues. The information it contains is
intended for use by L&TT programmers as a tool for debugging software issues within the program itself.

Generating an event log (Windows)

To generate an event log (Windows):

1. Run L&TT and select Options > Preferences.
2. Check the Add I/O history to event log option and click OK.
3. Exit and restart L&TT.
4. Replicate the problem encountered.
5. Navigate to the logs directory in the L&TT installation directory. Locate the Eventlog.ltt le.
6. Attach the Eventlog.ltt le to an e-mail and send it to the L&TT team for diagnosis.
7. Return to L&TT and select Options > Preferences.
8. Uncheck the Add I/O history to event log option and click OK.

This option should not be left enabled because it can potentially use hundreds of megabytes of
disk space.

In the log directory you may also see other event log entries such as EventLog_backup1.ltt,
EventLog_backup2.ltt, EventLog_backup3.ltt, and so on. The versions of the event log are
numbered in historical order.

Because the event log stores a SCSI trace of the interaction between the product and the L&TT software, it
can be used as a simple SCSI analyzer. To do this, select the Add I/O history to event log
option (as described in steps 1 and 2 previously) and make sure that you view the event log at the
factory only� detail level.

In escalations or integration situations, this can sometimes eliminate the need for a SCSI analyzer. All
SCSI commands and responses can be found in the event log if the Add I/O history to event
log option is enabled.

The event log can only capture I/O trafc from L&TT. It cannot be used to analyze trafc from other
applications or the OS.

Generating an event log (CSI)

To generate an event log (CSI):

1. From the Main screen, enter preferences.
2. Enter 4 at the command prompt, and select the check box.
3. Enter 5 at the command prompt, and then enter the value 128.
4. Exit and restart L&TT.
5. Replicate the problem encountered.
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6. Navigate to the logs directory in the L&TT installation directory. Locate the Eventlog.ltt le.
7. Attach the Eventlog.ltt le to an e-mail and send it to the L&TT team for diagnosis.

This option should not be left enabled because it can potentially use hundreds of megabytes of disk space.

In the log directory you may also see other event log entries such as EventLog_backup1.ltt,
EventLog_backup2.ltt, EventLog_backup3.ltt, and so on. The versions of the event log are
numbered in historical order.

The event log can only capture I/O trafc from L&TT. It cannot be used to analyze trafc from other
applications or the OS.
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